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A
Material da Avaliação Formativa

Todo o material da avaliação formativa realizada é apresentado neste

caṕıtulo.

A.1
Cenário

Marcos é um chefe de faḿılia de 30 anos e trabalha como gerente em uma

importante produtora de filmes, v́ıdeos e conteúdo multiḿıdia do Brasil. Completou

o Ensino Superior e é experiente em edição de v́ıdeos em ferramentas como Avid

e Final Cut. Entretanto, a experiência em informática não inclui programação.

Na última semana, o diretor da produtora contou a todos que agora eles

trabalhariam produzindo conteúdo interativo voltado para o novo padrão de TV

Digital brasileiro. Como gerente de produção de conteúdo, Marcos ficou responsável

em escolher o novo software que ajudaria a criar o conteúdo interativo.

Após diversos estudos, a sua equipe ficou em dúvida entre duas ferramentas:

o Composer e o NCLite. Coube a Marcos decidir qual das duas era a mais adequada.

Como não queria ser influenciado pelos integrantes da sua equipe, Marcos decidiu

analisá-las sozinho. Para isso, ele imprimiu um exemplo de utilização de cada

ferramenta. Feito isso, ele os analisou e tentou entender o que estava acontecendo.

Para facilitar, embaixo de cada tela dos exemplos ele escrevia o seu entendimento.

Se percebesse um detalhe de uma tela somente na seguinte, voltava e corrigia o

que escreveu. Com essa abordagem, Marcos conseguiu escolher a ferramenta com

a melhor interface para produtores como ele.

Imaginando que você é o Marcos, qual das duas ferramentas você escolheria

após analisar o exemplo? Por que a escolheu? Lembre-se de anotar embaixo de

cada tela o seu entendimento do que a ferramenta está fazendo.

A.2
Termo de Consentimento

O SERG, Grupo de Pesquisa em Engenharia Semiótica do Departamento

de Informática da Puc-Rio, desenvolve pesquisa cient́ıfica na área de Interação
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Humano-Computador (IHC), com o objetivo de contribuir para a crescente melhoria

da experiência de usuários com artefatos computacionais.

Convidamos você a participar de um de nossos estudos. Trata-se da avaliação

de um protótipo criado por integrantes do SERG e de um software desenvolvido

por um outro laborátorio da PUC-Rio, o Teleḿıdia. O propósito de ambos é o de

ajudar usuários que desejam criar aplicações interativas para o padrão brasileiro de

TV Digital (SBTVD).

Em nosso estudo, buscamos conhecer a interpretação dos sistemas apresenta-

dos por parte de alguns usuários para identificar oportunidades de aprimoramentos

tanto no protótipo quanto no software.

Gostaŕıamos de solicitar que você preencha um questionário com 5 questões

para traçar o seu perfil de usuário. Em seguida você será convidado a interagir

com os sistemas durante cerca de 30 minutos, tendo por objetivo final detalhar,

a partir de orientações fornecidas por nós, o seu entendimento sobre o sistema.

Gravaremos sua experiência em áudio e v́ıdeo através de uma câmera. Em nenhum

momento o seu rosto será gravado a fim de manter a sua privacidade. Finalmente,

ouviremos a sua opinião sobre a atividade realizada, em uma breve entrevista.

Para prosseguirmos, pedimos seu consentimento para realizarmos a avaliação

descrita acima, fornecendo a você algumas informações adicionais.

1. Os dados coletados destinam-se estritamente a atividades de pesquisa e

desenvolvimento, e somente os pesquisadores do SERG têm acesso à ı́ntegra

do material resultante da avaliação.

2. A divulgação dos resultados de nossa pesquisa em foros cient́ıficos e/ou

pedagógicos pauta-se no respeito à privacidade, e o anonimato dos

participantes é preservado em quaisquer materiais que elaboramos.

3. Sua participação na avaliação pode ser interrompida a qualquer momento, e

estamos dispońıveis para quaisquer esclarecimentos que você deseje, antes,

durante ou mesmo depois da realização da avaliação.

De posse das informações acima, você:

( ) Consente na realização do experimento.

( ) Não autoriza sua realização.

Rio de Janeiro,

Participante

Avaliador responsável
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A.3
Questionário do Perfil

1. Qual faculdade está cursando ou cursou?

2. Possui conhecimento de programação? Conhece NCL?

3. Quais ferramentas utiliza para edição de v́ıdeo? Conhece o Composer?

A.4
Telas do estudo

Todas as telas do Composer e da NCLite utilizadas no estudo são apresen-

tadas nesta seção. Vale lembrar que selecionamos o exemplo 9 da segunda edição

do Tutorial NCL (Tutorial NCL 3.0, 2007) e o reproduzimos no Composer e na

NCLite.

Figura A.1: Visões de Leiaute e Temporal
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Figura A.2: Visão de Leiaute

Figura A.3: Visões Estrutural e Temporal

DBD
PUC-Rio - Certificação Digital Nº 0812562/CA
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Figura A.4: Visão Estrutural

Figura A.5: Visão Temporal
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Figura A.6: Visão Textual

Figura A.7: Parte 1 do exemplo da NCLite
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Figura A.8: Parte 2 do exemplo da NCLite

Figura A.9: Parte 3 do exemplo da NCLite
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Figura A.10: Parte 4 do exemplo da NCLite

A.5
Resumo das sessões dos participantes

Nesta seção apresentamos e destacamos os pontos mais interessantes da

interpretação e da entrevista com cada um dos participantes. Para uma melhor

análise, eles foram separados em dois grupos, o primeiro contém os participantes

que começaram a interpretação pelo Composer e o segundo os que iniciaram pela

NCLite. Sendo assim, os integrantes do primeiro grupo são Alexandrita, Esmeralda

e Rubi e o segundo é composto por Ágata, Diamante, Opala e Safira. Essa é a

ordem em que os participantes são apresentados a seguir.

Alexandrita

Este participante começou pelo Composer. Não conseguiu escrever nada

olhando somente a tela da visão estrutural e, por isso, olhou todas para tentar

entender. Compreendeu que a visão estrutural era onde armazenávamos os takes

(ou tomadas, em português), algo como uma biblioteca de takes, e a visão

temporal era onde deveria ser feita a edição propriamente dita. Sendo assim,

quando apresentamos essas duas visões em conjunto, o participante entendeu que

os takes v́ıdeo 1 e botão vermelho eram levados da visão estrutural para a temporal

para serem editados. Ainda na visão temporal, o participante também entendeu

que a seta que leva o final do v́ıdeo 1 para o final do v́ıdeo 2 era uma edição com
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o mouse que fazia com que o take v́ıdeo 1 fosse diminúıdo e se transformasse no

v́ıdeo 2.

A visão textual foi entendida como sendo um gerenciador de comandos e

o participante também afirmou que essa visão não é nada prática. Já a visão

de leiaute ele entendeu como sendo um componente diferente para visualizar os

takes dispońıveis. Isso foi percebido quando as visões de leiaute e temporal foram

visualizadas em conjunto e o participante escreveu que “a visualização do programa

é parecida com o Windows Movie Maker1. Lado direito (visão temporal) ficam as

imagens, lado esquerdo (visão de leiaute) o tamanho dos takes”.

A NCLite foi entendida como uma ferramenta de efeitos, algo parecido com

o After Effects só que bem mais simples. O participante escreveu que o exemplo

apresentado era um efeito de camêra invertida. A visão temporal foi corretamente

compreendida.

Com a entrevista foi posśıvel analisar melhor as dificuldades do participante.

“Tive dificuldade no Composer, mas como ele parecia com After Effects e Vegas

Pro, acho que entendi algo da ferramenta. Para mim a NCLite é uma ferramenta de

efeitos do Composer. Para editar usaria o Composer, se quisesse invertar posição

do v́ıdeo ou aumentar/diminuir usaria a NCLite”. Inicialmente, teve dificuldade

em entender a visão estrutural. Depois percebeu que deveria pegar os takes da

estrutural e jogar para a temporal onde editaria.

Quando perguntado sobre a NCLite, afirmou que não sabia como trocava da

cena 1 para a 2 e que percebeu com clareza mudanças na visão temporal.

Quanto à escolha da ferramenta, afirmou: “Escolheria o Composer pelo fato

de saber como criar a timeline. Com a Composer eu tenho como editar, mas com a

NCLite eu não edito. Com ela eu crio efeitos. Se fosse só para criar efeitos simples,

ficaria com a NCLite”.

Esmeralda

Logo que começou, o participante abriu todas as telas do Composer para

poder entender a ferramenta. Escreveu na tela que apresentava as visões estrutural

e temporal (Figura A.3) que o exemplo era semelhante a uma construção de menu

do DVD Studio Pro2. Os conectores da estrutural seriam o mapeamento das ḿıdias

para formar o menu. O participante afirmou ainda que a visão temporal “seria

uma espécie de zoom da visão estrutural. Por exemplo, a visão temporal exibida é

uma redução da estrutural na conexão do v́ıdeo 1 com o v́ıdeo 2”. Ficou claro o

objetivo da visão de leiaute, mas não o da visão textual. Considerou que essa visão

era somente para visualizar e não editar.

1http://www.moviemakerpreview.com/
2http://www.apple.com/finalcutstudio/dvdstudiopro/
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Assim como no Composer, o participante precisou abrir todas as telas

da NCLite para escrever o seu entendimento. Os componentes Media Library,

Properties e Spatial View foram compreendidos sem problemas. Entretanto, não

entendeu os componentes cenas interativas e ḿıdias interativas. Continuou com

a ideia de menu de DVD e achou que as cenas seriam o mapeamento das ḿıdias

para formar o menu.

Considerou ainda que as ḿıdias presentes no Media Library com formato

MPEG4 seriam os v́ıdeos visualizados na execução e as com extensão JPEG seriam

imagens que exemplificariam de forma estática esses v́ıdeos. Com essa afirmação,

observamos que o participante mudou o seu entendimento do componente.

Na entrevista, algumas questões percebidas na interpretação ficaram mais

claras. O participante novamente descreve o entendimento de que são “ferramentas

para criar menu. No caso da NCLite, teria menos opção de criação. O Composer

tem várias formas de visualizar a mesma coisa, você tem vários caminhos para

chegar até o mesmo objetivo. Ele dá um pouco de medo, mas parece ser mais exato

de trabalhar”. Além disso, afirmou que analisou mais a estrutura das ferramentas

e não o conteúdo espećıfico de cada componente gráfico.

Considerando somente o Composer, também falou que achou “a visão textual

e estrutural muito similares, só alterando a forma que apresentam as informações”.

Também reafirma o que escreveu sobre a visão temporal ser um zoom da estrutural.

Já sobre a NCLite, a considerou bem simples e que o destaque em verde (a

indicação de seleção do elemento) representaria a execução do v́ıdeo.

Caso precisasse escolher alguma ferramenta, escolheria o Composer porque

tem várias maneiras de chegar ao mesmo objetivo e, dessa forma, é posśıvel usar

a mais adequada ao seu método de trabalho.

Rubi

Iniciando pelo Composer, o participante interpretou a visão estrutural como

sendo um fluxograma do projeto sendo editado. Ele entendeu também que as

setas dessa visão apontavam para o elemento que acionou a execução do elemento

presente na origem da seta. Ainda na estrutural, ele entendeu, pela nomenclatura,

que as imagens funcionavam como botões.

Passando para a visão temporal, o participante só não compreendeu a seta

pontilhada vermelha e as setas iniciais passaram despercebidas. Considerou a visão

textual como equivalente à temporal só que com edição direta no código fonte. Já

a visão de leiaute foi corretamente entendida.

Na NCLite compreendeu corretamente os componentes Temporal View,

Spatial View, Properties e Media Library. O conceito de cenas parece que não

foi entendido. Percebemos isso por ele afirmar que as telas um, dois e três
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(respectivamente, Figuras A.7, A.8 e A.9) tratam da mesma cena mas que a

terceira está em outro momento do tempo com outro v́ıdeo e outro botão. Só para

lembrar, a cena da NCLite exibida muda na terceira tela.

Na entrevista confirmamos algumas observações da interpretação. Pergun-

tado sobre a dificuldade das ferramentas, primeiro falou do Composer: “Tive muita

dificuldade em entender a visão estrutural no Composer. Ele parece ser mais con-

fuso do que a NCLite”. Sobre a NCLite afirmou ainda: “A NCLite me pareceu ser

melhor e mais intuitiva. Mas não consegui saber até quando seria a cena 1 e o

momento que mudava para a cena 2”.

Sobre a escolha de uma ferramenta, ficou com a que considerou mais fácil

de usar. “Escolheria a NCLite por ser mais simples. O Composer pareceu ser mais

completo, mas também confuso”.

Ágata

Iniciando pela NCLite, o participante conseguiu logo na primeira tela (Figura

A.7) interpretar corretamente os componentes Spatial View, Temporal View,

Properties e Media Library. Já os componentes Interactive Scenes e Interactive

Media só entendeu quando fez uma comparação entre a segunda e a terceira telas

(Figuras A.8 e A.9). O participante não compreendeu se as propriedades referentes

ao tamanho do v́ıdeo correspondiam ao tamanho real do v́ıdeo exibido na visão

espacial ou ao tamanho estabelecido para a aplicação final. Ficou em dúvida se

a visão temporal funcionava em camadas como as ferramentas que utiliza. As

camadas fazem com que as ḿıdias das camadas superiores fiquem à frente das

ḿıdias das inferiores na visão espacial.

Passando para o Composer, começou analisando a visão estrutural e entendeu

que existia uma interação entre os elementos apresentados, mas não sabia dizer ao

certo como se daria essa interação. Na visão temporal interpretou que ao fim do

v́ıdeo 1 deveria apertar o botão vermelho para mudar para o v́ıdeo 2. Não soube

ao certo “se as setas anteriores aos v́ıdeos também permitiriam acesso ao botão

vermelho para ver o v́ıdeo 2”. Interpretou corretamente a visão de leiaute, só sentiu

falta do bottom e right. Quanto à visão textual, escreveu: “Isso é de assustar!”.

Mesmo assim achou fácil entender os atributos dos elementos media e property.

Preferiu a tela que apresentava as visões estrutural e temporal em paralelo por

parecer que tinha maior controle. Quando observou as visões de leiaute e temporal

em paralelo ficou na dúvida como deveria inserir elementos na temporal.

Quanto à entrevista, começamos perguntando o que achou da experiência.

O participante afirmou que “é estranho olhar tela no papel. Você tem vontade

de testar/fuçar para ver se deu certo ou errado”. Ainda assim achou interessante

porque “quando você lê a tela, você presta atenção em algo que passaria desper-
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cebido e te levaria para um caminho errado”. Durante a observação, percebemos

que o participante abriu todas as telas para entender o processo antes de chegar

a uma conclusão. “Se olhar somente a primeira tela pode paralisar e desistir”. Ele

afirmou ainda que no Composer sentiu maior necessidade de olhar todas as telas

para poder entender.

Caso precisasse escolher alguma ferramenta, como sugerido no cenário,

escolheria a NCLite porque está mais próxima das ferramentas conhecidas. “Tenho

mais controle de tudo. Quando você me apresentou a primeira tela do Composer,

tinha somente a visão estrutural. Eu não tinha mais nada ali. Isso me assustou.

A NCLite eu de cara já conseguia identificar elementos parecidos com outras

ferramentas de edição. Como a ḿıdia vai aparecer na tela, as informações de

cada elemento, quais os botões de interatividade”.

Ainda sobre o Composer, o participante afirmou que precisaria testá-lo

em um computador para saber se é complicado como aparenta ser. Considerou

também que a “visão textual é assustadora para não programadores”. Além disso,

sentiu falta da visão espacial e também de uma maior relação entre as visões.

Afirmou ainda que não conseguiu descobrir o objetivo dos relacionamentos da

visão estrutural, além de considerar essa visão confusa.

Quanto ao exemplo do Composer e do NCLite, os achou parecidos porque

ambos trabalham com v́ıdeos e botões e existe uma estrutura de ir e vir onde os

botões levam a v́ıdeos diferentes.

Diamante

Ao iniciar a interpretação, o participante escreveu direto nas primeiras telas

da NCLite. Quando chegou na terceira (Figura A.9), ficou em dúvida, olhou a

seguinte e voltou a analisar as telas anteriores. Continuou a descrever as telas até

chegar na última (Figura A.10). Nesse momento, abriu todas as telas novamente

e passou a escrever todo o seu entendimento de novo.

Analisando as duas partes do entendimento do participante, percebemos que

na primeira ele se fixou nos componentes Interactive Scenes, Interactive Media

e Properties. Entretanto, não compreendeu completamente como as cenas se

relacionavam. Na segunda parte, conseguiu entender o funcionamento das cenas

e do componente Media Library, mas não percebeu que a visão temporal era uma

linha do tempo. Considerou que este componente somente exibia os elementos

presentes na cena em questão.

Dando continuidade ao estudo, o participante analisou o Composer. Começou

pela visão temporal e teve dúvidas em descrever o que essa visão estava fazendo.

“Visão temporal: eu tenho ou dois v́ıdeos mais um botão ou v́ıdeo 2 sendo chamado

do v́ıdeo 1. Parece haver algum tipo de ação associada ao botão”. Interpretou ainda
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Apêndice A. Material da Avaliação Formativa 116

que o ı́cone usado pelo Composer para indicar que o v́ıdeo 1 é a ḿıdia inicial a ser

executada durante a execução representava a existência de áudio no v́ıdeo 1 e a

ausência no v́ıdeo 2.

Na visão estrutural escreveu: “Não faço ideia do que representam os conec-

tores. A visão estrutural não faz sentido”. Quando analisou as visões de leiaute e

temporal juntas considerou que elas não possúıam os mesmos elementos.

Quanto à entrevista, começamos perguntando o que achou da experiência

devido à dificuldade encontrada na NCLite. O participante afirmou que “é mais

fácil quando vc está mexendo no programa propriamente dito do que pelas telas”.

Passamos para o Composer e o participante nos contou que “ela lembra um pouco

a interface do Flash, mas várias coisas não fazem sentido na maneira como é

mostrada. Principalmente a visão estrutural, para mim não faz o menor sentido.

Os conectores deixam quem está acrescentando elementos completamente perdido.

Eu vejo que existe uma conexão, que diz algo para o programador, mas para mim

não diz nada”.

Em relação à NCLite, disse que é “muito mais fácil mexer nela do que

no Composer”. Explicou ainda o seu entendimento sobre as cenas, mas fez

uma ressalva: “Na NCLite não vejo como criar/inserir novos elementos. Só vejo

informações da cena montada. Não vejo como montar, como colocar aquele botão

ali, como inserir a interatividade. Parece um programa pronto, onde você vê a

estrutura de uma aplicação criada”.

Perguntado sobre qual das duas ferramentas escolheria, afirmou que usaria

as duas em conjunto porque o Composer não exibe um retorno do que está sendo

criado, mas possibilita criar/inserir conteúdo. Já a NCLite é mais fácil de usar e

muito boa para visualizar mas parece não oferecer a possiblidade de criar.

Opala

Analisando a NCLite, o participante conseguiu entender corretamente os

componentes Spatial View, Temporal View e Properties. Entretanto, os compo-

nentes referentes às cenas não foram compreendidos. O participante interpretou

que as imagens (botões) que alteravam as cenas eram parte da interface gráfica

e não do conteúdo interativo sendo criado. Percebemos isso pela afirmação: “A

ideia das visões de câmera é boa, mas poderia ser mais objetiva”. Além disso,

verificamos que ele levou em consideração a parte visual da interface.

No Composer, o participante analisou mais a parte visual das diferentes

visões. Quanto ao entendimento, a visão de leiaute considerou como sendo um

painel para criação de botões e a visão temporal conseguiu interpretar como uma

linha do tempo mas não entendeu os relacionamentos que as setas proporcionavam.

Percebeu que a visão textual servia para edição do código fonte. Finalmente,
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considerou a visão estrutural confusa e não conseguiu entender os relacionamentos

presentes.

Pela entrevista percebemos que o participante conhece uma gama consi-

derável de ferramentas. Ele achou tanto o Composer quanto a NCLite parecidos

com Flash, After Effects, Final Cut e Adobe Premiere. Confirmamos que o parti-

cipante ficou muito preso ao visual gráfico das ferramentas, ele afirmou que não

gostou do visual da NCLite e justificou: “Acho que o visual deixa a pessoa mais

confortável para trabalhar. Ela pode achar que a interface está mal feita se tiver

um visual ruim”3.

Quanto às cenas da NCLite, ele não conseguiu descobrir como acontecia o

seu funcionamento. “As cenas ficaram confusas, não entendi se podia interagir

com as duas ao mesmo tempo. Se clicasse em uma ou outra iria para aquela cena.

Isso não ficou claro”. Interpretou ainda que os elementos da media library eram

visões de câmera e que através deles seria posśıvel escolher a câmera da esquerda,

do topo ou alguma outra posição. Dessa forma, percebemos que interpretou os

botões de interatividade que alteravam as cenas como componentes da interface

gráfica para a escolha da câmera.

Perguntado sobre qual das duas ferramentas escolheria, afirmou: “Ficaria

na dúvida se tivesse que escolher. A NCLite me apresenta mais informação para

desenvolver o projeto, mas o Composer apresenta a linguagem que pode facilitar

para quem entende de programação. Só utilizando no computador para saber”.

Safira

Assim que olhou a primeira tela (Figura A.7) da NCLite começou a escrever,

mas sempre que passava para uma seguinte retornava à anterior e as comparava.

Percebeu semelhança com o After Effects em relação à disposição das informações

na interface gráfica. Entendeu corretamente os componentes Spatial View, Proper-

ties e Media Library logo na primeira tela. Já os componentes Interactive Scenes

e Interactive Media só foram entendidos na terceira tela (Figura A.9) após com-

parações com as anteriores.

Por fim, percebemos também que o participante não entendeu o componente

Temporal View como uma linha do tempo. As primeiras linhas escritas na análise

do Composer nos confirmam essa percepção: “Reparei logo na existência de uma

timeline, que se assemelha ao After Effects, mas que não havia no outro teste”.

No Composer, o participante percebeu a linha do tempo da visão temporal

facilmente, mas na visão estrutural não escreveu nada sobre os elementos presentes

3O avaliador responsável pelo estudo explicou posteriormente que o objetivo da NCLite

era justamente transmitir a imagem de uma interface gráfica não finalizada e desenhada a

mão.
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nela. Pareceu que ele não conseguiu compreender o conteúdo dessa visão. Entendeu

de maneira correta a visão textual. Por fim, na visão de leiaute escreveu que o v́ıdeo

1 parecia habilitado e que não entendeu o propósito dos botões verde e vermelho.

Na entrevista, algumas questões percebidas na interpretação ficaram mais

claras. Em relação ao ir e vir entre as telas do NCLite, o participante afirmou:

“Voltei para analisar a dinâmica da seleção e onde leva cada comando. São quatro

telas, cada hora com um botão ou câmera selecionado, eu voltei para entender a

lógica”. Falou também que não sentiu dificuldade em entender essa ferramenta.

Perguntado sobre o Composer, disse que o achou “mais complexo. Se

assemelha mais ao Flash, com uma parte só para programação”. Conseguiu

entender alguns componentes, mas afirmou que “o problema foi a visão estrutural

e a de leiaute. Não cheguei a um propósito para essas visões e não entendi a relação

entre elas. Voltei às telas para tentar fazer uma relação, mas não consegui”.

Caso precisasse escolher, disse que “escolheria a NCLite porque achei mais

fácil de usar e entendi o propósito dos componentes”.
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B
Estendendo a implementação da NCLite

Neste caṕıtulo detalhamos como deve ser feita a recuperação e a montagem

do ambiente para estender a implementação da NCLite.

B.1
Recuperando o código fonte

Até o momento da finalização desta dissertação nenhuma versão estável

da NCLite foi liberada. Porém uma versão usável pode ser baixada diretamente

da linha principal de desenvolvimento. As informações aqui demonstradas tanto

servem para sistemas operacionais Windows quanto para Unix.

Para obter o código fonte da NCLite, são necessários:

1. Cliente SVN de linha de comando (pode ser outro equivalente, como o

Tortoise, porém será demonstrado aqui usando apenas linha de comando).

Dispońıvel em http://subversion.tigris.org;

2. Usuário cadastrado nos repositórios. Vale ressaltar que a localização do

repositório pode vir a ser alterado por questões técnicas. Caso não consiga

recuperar o código fonte através do passo-a-passo apresentado, entre em

contato com os autores;

3. Conexão com a internet dispońıvel.

A NCLite depende do componente NCL-Parser, que foi desenvolvido em con-

junto com outro aluno de mestrado (Gustavo Honorato), que também não possui

uma versão estável. Portanto, antes de recuperar o código da NCLite, precisaremos

fazer o mesmo para o NCL-Parser. Crie um diretório para armazenar as cópias de

trabalho do código fonte da NCLite e do NCL-Parser. Iremos chamar essa pasta

de workspace. Na linha de comando, entre dentro da pasta criada e chame o

comando: svn checkout http://ncl-parser.googlecode.com/svn/trunk/ncl-

parser. No final da execução do comando é criada uma pasta chamada

ncl-parser com o código fonte completo do NCL-Parser.

Agora devemos recuperar o código fonte da NCLite. Ainda no diretório

workspace execute o seguinte comando: svn checkout https://ideias.inf.puc-

rio.br:8443/svn/htrannin/workspace/nclite/trunk/source nclite. A pasta
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nclite é criada com todos os projetos da ferramenta. Atualmente, esses projetos

são os seguintes:

– br.pucrio.inf.serg.nclite

– br.pucrio.inf.serg.nclite.auxiliary-components

– br.pucrio.inf.serg.nclite.edit

– br.pucrio.inf.serg.nclite.gui-rcp

– br.pucrio.inf.serg.nclite.persistence

– br.pucrio.inf.serg.nclite.scenes

– br.pucrio.inf.serg.nclite.spatial

– br.pucrio.inf.serg.nclite.timeline

A NCLite depende ainda das bibliotecas Jaret Timebars v1.41

e Xuggler. Para realizar o download da Jaret Timebars é pre-

ciso ir à página http://www.jaret.de/timebars/index.html e cli-

car no link timebars-1.41-bin.zip. O componente Timebars de-

pende do componente Utils v0.32, por isso precisamos ir à página

http://www.jaret.de/jaretutil/index.html e fazer o download do arquivo

jaretutil-0.32-bin.zip. Terminada essa parte, precisamos agora descompac-

tar os arquivos baixados e copiar os arquivos .jar para o diretório lib/jaret

dentro da raiz do projeto br.pucrio.inf.serg.nclite. Caso esse diretório não

exista, é preciso criá-lo.

Finalmente, precisamos recuperar a biblioteca Xuggler v3.4. Vá até o

site http://www.xuggle.com/xuggler/downloads/ e faça o download da

versão correspondente ao seu sistema operacional. Após a recuperação do

arquivo, é preciso instalar a biblioteca. Na própria página onde foi feito o

download temos uma explicação de como instalá-la. Além disso, na página

http://blog.xuggle.com/2009/01/23/how-to-install-xuggler-on-microsoft-windows/

encontramos um exemplo com v́ıdeos da instalação no Win-

dows. Terminada a instalação, copie os arquivos .jar da pasta

DIRETORIO_DA_INSTALACAO/xuggler/share/java/jars/ para o diretório

lib/xuggler dentro da raiz do projeto br.pucrio.inf.serg.nclite. Nova-

mente, se esse diretório não existir, é preciso criá-lo.
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B.2
Preparando o ambiente

Para continuar o desenvolvimento da NCLite é preciso configurar o ambiente

completo do Eclipse-RCP. Para isso precisamos dos seguintes componentes:

1. Eclipse for RCP/Plug-in Developers 3.5 (Galileo)

2. subclipse (plugin do Subversion para o Eclipse)

3. m2eclipse (plugin do Maven para o Eclipse)

4. Graphical Editing Framework (GEF) plugin

5. Eclipse Modeling Framework (EMF) plugin

Para realizar o download do Eclipse vá ao site http://www.eclipse.org/downloads/

e selecione a versão do Eclipse de acordo com a Figura B.1. Terminado o down-

load, descompacte o arquivo. Isso resultará na criação da pasta eclipse. Dentro

desta pasta, execute a aplicação através do arquivo eclipse.exe no Windows

ou eclipse no GNU/Linux.

Figura B.1: Página de download do Eclipse-RCP

Ao iniciar, o Eclipse pedirá para selecionar uma pasta para armazenar seu

workspace. Selecione a pasta onde recuperamos o código fonte da NCLite e do

NCL-Parser e clique em OK.

O próximo passo, será a instalação do plugin do Eclipse para

integração com o SVN. Para prosseguir, clique na opção de menu
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Help > Install new software.... Irá aparecer a janela apresentada na Figura

B.2 e então clique no botão Add. Na nova janela digite no campo Location a

URL http://subclipse.tigris.org/update_1.6.x e clique em OK.

Selecione todos os plugins, clique em Next. Prossiga pelo assistente e aceite

os termos da licença e clique em Finish. É posśıvel que o Eclipse apresente uma

mensagem pedindo a confirmação para instalar um conteúdo não-assinado. Se isto

ocorrer, permita que o conteúdo seja instalado. Será solicitado o reinicio do Eclipse

quando a instalação terminar.

Figura B.2: Janela de instalação de plugins do Eclipse

A seguir instalaremos o plugin do Eclipse para integração com o Maven.

Clique novamente na opção Help > Install new software... para aparecer

a janela da Figura B.2 outra vez. Clique no botão Add, digite no campo Location

da janela aberta a URL http://m2eclipse.sonatype.org/update/ e clique em

OK.

Selecione todos os plugins e clique em Next. Prossiga pelo assistente e aceite

os termos da licença e clique em Finish. Novamente, permita a instalação de

conteúdo não-assinado e reinicie o Eclipse após a instalação.

Continuando, é preciso instalar também o plugin do GEF.

Vá outra vez para a janela de instalação de novos plugins e cli-

que no botão Add. Agora insira no campo Location a URL

http://download.eclipse.org/tools/gef/updates/releases/ e clique

em OK. Selecione todos os plugins de GEF SDK 3.5.2 e prossiga pelo assistente

como descrito acima.
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Finalmente, a última instalação é o plugin do EMF. Vá

para a janela de instalação de novos plugins de novo e cli-

que no botão Add. Agora insira no campo Location a URL

http://download.eclipse.org/modeling/emf/updates/releases/ e cli-

que em OK. Selecione todos os plugins da opção EMF SDK 2.5.0 (EMF + XSD)

e prossiga pelo assistente como descrito anteriormente.

B.3
Configurando os projetos

Terminada a preparação do ambiente, precisamos agora configurar os projetos

no Eclipse. Para isso, clique na opção de menu File > Import. Na janela que

abrir, escolha a opção Existing Projects into Workspace como exibido na

Figura B.3 e clique no botão Next. Na tela seguinte, clique em Browse da opção

Select root directory e selecione a raiz do workspace. Todos os projetos

descritos acima estarão marcados, incluindo o NCL-Parser. Clique em Finish para

terminar.

Figura B.3: Janela para importação de projetos existentes

Os projetos irão aparecer com alguns erros porque falta recuperar algumas

bibliotecas. Essa recuperação é feita pelo plugin do Maven que instalamos anteri-

ormente. Clique com o botão direito do mouse no projeto ncl-parser e escolha

a opção Run as > Maven install. Espere um tempo para poder baixar as de-

pendências e compilar o projeto. Quando terminar, faça o mesmo para o projeto
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br.pucrio.inf.serg.nclite. Ao final de tudo, não teremos mais nenhum erro

de compilação e já será posśıvel estender a implementação da NCLite.

É importante lembrar que o projeto a ser executado é o

br.pucrio.inf.serg.nclite.gui-rcp porque, como detalhado no Caṕıtulo

5, este projeto é o núcleo que agrupa todos os módulos e gera uma aplicação

separada do Eclipse.
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